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1. INTRODUCTION. 
 
The “BC 2000 D Router - Multiplexer“ is a high-performance summing and distributing matrix 
for digital and analog audio switching. Like all mission-critical equipment, it has been designed 
with criteria in mind to guard against user errors and equipment failures. 
 
This system also enables users to insert and extract digital or analog audio channels in 
E1/T1/J1 or Ethernet data transmission flows, with added audio encoding/decoding capabilities 
at different quality levels and in diverse formats. 
 
Two configuration and control applications have also been designed, using the same criteria:  
 

• “BC 2000 D Matrix Setup“ configures the equipment and the work environment;  
• “BC 2000 D Matrix RTC“, the subject of this document, makes it possible to control 

and use the switching matrix in real time. 
 
More effective learning is achieved through training given by specialized technicians who know 
the system. This document is for reference purposes, and it is organised according to the drop-
down menus on the menu bar. 
 
 
2. IP ADDRESS CONFIGURATION. 
 
In order to use “BC 2000 D Matrix RTC“ application it is necessary that the IP address 
configured in the software and the “Cluster IP“ of the BC2000D frame are the same. 
 
Once the “BC 2000 D Matrix RTC” application is installed (by default in C:\Program files 
\AEQ\BC-2000 D\Matrix Software\RTC), you can start it up by double-clicking the icon displayed 
on the desktop: 

 
 
When the application starts up, the following window is displayed 
indicating that the software is trying to connect with the frame: 
 
 
 
 
 
 
If the IP address configured in the software and the “Cluster 
IP“ are different, the following window appears where you 
can configure the right IP (it also appears if the IP is correct 
but the software can not connect with the active controller): 
 

 
 
 
 
When you validate (“OK“), the application tries again to 
connect with the frame. If the new IP is the right one, the 
following window is displayed to request identification from 
user (with the corresponding password) to access to 
application: 
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3. APPLICATION BASE SCREEN. 
 
When you access to “BC 2000 D Matrix RTC“ application, the following window appears (if 
there is no default view selected: see section 4.7). From this window you have access to all the 
drop-down menus that are explained in the following sections. 

 
At the bottom of the window, the following information is displayed: 
 

• Date and time (when synchronization with an NTP Server is configured, the date 
and time of the controller will be automatically adjusted with the configured refresh 
interval). 

• IP address: is the Cluster IP of the frame that is connected to the application. 
• Application connection status. There are 3 options: 

 
   : no connection established. 

                                              : connection establishing. 

                        : connection established. 
 

• User (when the application starts up, before user identification, it shows “Not 
logged”). 

• Alarm indicador: it appears blinking if the system detects a situation that has been 
programmed to generate an alarm. 

 
When you send a configuration to the system by means of “BC 2000 D Matrix Setup” 
application and “BC 2000 D Matrix RTC” application is open in any workstation, at the bottom 
part of the previous window the following indication will appear: 

 

 
 

If you just close and open again the application, the new configuration will be downloaded from 
the frame and the changes will be available in the system. 
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4. DROP-DOWN MENU: FILE. 
 
4.1. New Logical XY View. 
 
This view enables you to control the connection between a selection of logical lines in XY 
format. Each connection of an input to an output is shown, and is shown and made at the cross 
point between the row and the respective column.  
 
The screens with real-time views can be configured according to the user’s needs. Starting with 
the minimum possible size for each logical line, the space occupied by each line is readjusted 
to fit the size of the window, thus displaying all of the lines selected in that view. If there are 
more lines than can be shown in one window, scroll bars will be displayed.  
 
The labels for each line can also be edited in real time, although when the session is closed, 
these changes will be lost, as they are momentary and depend on the use of the line at that 
particular moment.  
 
When you select “New Logical 
XY View“, the following window 
appears: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4.1.1. Creating customized views. Custom. 
 
When “Custom…” button is pressed, a context menu that allows you to change the name of 
the view (“Rename View“) or prepare a new one (“Customize“) appears. 
 
This last option will provide 
access to this screen to 
customize the current view, in 
which visible input and output 
lines can be added or 
removed: 
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The “All Lines” button creates an XY view with all of the logical lines previously defined by 
means of “BC 2000 D Matrix Setup“ application. 
  
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 adds an input or output line to the view (it is inserted in the selected position of the list) and 
 removes it. With the up and down arrows, the selected line is moved up or down until it is 

located as desired.  
 
When the button  is pressed, the following window appears, in which you can choose the 
lines to be added (you can filter the records that are shown to facilitate the search by name, 
description, line type or working group):  
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Once you have adjusted the XY view a window similar to this appears: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4.1.2. Actions on cross points. 
 
The following buttons, at the top of the window, make it possible to edit the cross points 
selected:  
 

 
 

• Take: Activates or deactivates the selected cross points to connect (green cross 
points) or disconnect (red cross points) the respective logical lines.  

• Protect: Sets the status of the cross point to protect against incorrect actions. 
• Close XY: Closes the window. 

 
When you place the cursor over the cross points you wish to establish and then select them, 
they will be marked in green. When you press “Take”, the selected cross points are activated, 
and will be indicated in blue. 
 
If you place the cursor over one or several established cross points (marked in blue) and then 
select them, they will be marked in red. Pressing “Take” deactivates the selected cross points, 
removing their colour.  
 
If cross points are selected at the same time to connect and disconnect, when “Take” is 
pressed, the respective action for each cross point will take place. 
 
The priority level that will be applied to a certain cross point between two logical lines will 
always be set by the priority level of the user that activates it. When there are several defined 
users with different priority levels and a user with a higher priority than the current one has 
established a series of cross points, those will appear marked in purple and it will not be 
possible to modify them unless we change to that user or to another with a higher priority. 
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At the bottom of the window, the input and output associated with each cross point will be 
displayed when the mouse cursor is placed over that cross point. 
 
When the mouse is placed over a connected and/or protected cross point a 
message appears showing the priority levels of connection and/or protection 
associated to that cross point. When you don’t have enough priority level 
regarding a connected cross point, this will appear in purple colour. 
 

 
  

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 

 
From the “Logical Lines XY View” screen you can also execute previously defined salvos and 
macros. 

  
Both salvos and macros can be user-defined and can be associated with different groups. From 
“Logical Lines XY View” you can select a group, for both salvos and macros, and within that 
group you can choose a specific salvo or macro.  
 
You can connect the salvo (“Take“) or disconnect  it (“Release“). If any of the cross points on 
which you want the salvo to act are protected (or have been established by a user with a higher 
priority than the current one), a window will appear showing the conflicts in the execution of the 
salvo: 
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The  button allows you to cancel the salvo execution. 

The  button allows you to execute the part of the salvo that creates no conflicts (the 
deactivation of the last 2 cross points). You will be asked for a confirmation: 
 

 
 
To execute the salvo completely, you can select the “Override” option: when you make this 
selection, the protection will be ignored and the cross point will be connected or disconnected, 
as appropriate. 
 
 
The following example shows 2 cross points that have been activated by a user with a higher 
priority than the current one (marked in purple) and 2 additional cross points activated by a user 
with the same or lower priority than the current one (marked in blue). 
 

 



       

       BC 2000 D Router 
Real-time control software for the switching matrix 

 

10

If now we execute the “DIG 01-02 OFF” salvo, configured to deactivate these 4 cross points, 
the following window appears, showing the conflicts in the execution of the salvo (in this case, 
the first 2 cross points): 
 

 
 

The  button allows you to cancel the salvo execution and the  button allows you to 
execute the part of the salvo that creates no conflicts (the deactivation of the last 2 cross 
points). You will be also asked for a confirmation. 
 
 
The execution of a macro (“Exec”) follows the same procedure. If the macro entails the 
connection or disconnection of a protected cross point (or a cross point established by a user 
with a higher priority than the current one), the macro will not be fully executed unless the 
“Override” option has been selected. 
 
 
A special case appears with the 
“Conference/Multiplex” (or “4 wires”) lines. This type 
of lines will appear in the XY view as input and output 
lines. 
 
In order to establish the routing of these lines, it’s 
enough to create one of the cross points (from “4W1” 
input to “4W2” output, for instance) because the other 
one will be created automatically. The same thing 
happens when we disconnect one of these cross 
points: both of them disappear. 
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4.1.3. Actions on lines or cross points. Context menu. 
 
In the “Logical Lines XY View” screen, you can use the following 
context menu displayed by right-clicking the mouse over a cross 
point: 
 
 
On each cross point you can configure the gain of the cross point 
itself, protect it, activate or deactivate it and see the physical 
connections. It is also possible to change temporarily the label of 
the input and output lines that this cross point consists of. 
 
 
 
 
 
 
If you select an input line, a right mouse click will open the 
following context menu indicating at the top the line selected 
on a red background:   
 
 
On each input line you can configure the gain, activate or 
deactivate processes and change temporarily the line label. 
You can also obtain an individual display of the signal by 
means of a vumeter. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If the selected input line is “Test Line“ type, a right mouse 
click will open a context menu slightly different: 
 
 
You can also configure the gain and change temporarily the 
line label, but the processes list is replaced by the “Test 
Tone“ option. 
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If you select an output line, a right mouse click will open the 
following context menu indicating at the top the line selected on a 
red background:   
 
On each output line you can configure the gain, change 
temporarily the line label and obtain an individual display of the 
signal by means of a vumeter. 
 
 
 
 
 
 
 
 
 
 
The different options available in the context menu are described next. 
 
 
4.1.3.1. Take. 
 
Connects or disconnects the pre-selected cross points. This option is only available in the 
menu associated to cross points. 
 
 
4.1.3.2. Protect. 
 
This option protects the cross point to avoid it being connected or disconnected, depending on 
the status the cross point had before to apply the protection. This option is only available in the 
menu associated to cross points. 
 
 
4.1.3.3. View Physic XY Layer. 
 
Shows the physical connections of the cross 
point, according to the layers assigned to those 
logic lines (“Cross Layer”) and the type of 
routing established in the setup software. When 
the mouse cursor is placed over a connected 
cross point, the connection of the physical input 
and output lines is shown in dark blue; when the 
cross point is not connected, the way that 
connection will be done when the point is 
activated is shown in lighter blue. 
 
This option is only available in the menu 
associated to cross points. 
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When the cross point is between 2 “Conference/Multiplex” (or “4 wires”) lines, this window will 
look as follows: 
 

 
 
 
4.1.3.4. Gain Control. 
 
This option lets you adjust the digital gain for each of the physical components of the logic line. 
You can adjust the input line, the output line or the cross point, depending on the exact point on 
the screen where the mouse cursor has been placed. If the logic line has several channels all 
of them will be shown in this window. The gain of those channels can be adjusted 
simultaneously or separately by activating or not the “Change All” checkbox. The phase of 
each physical line can be inverted too.  
 
The gain of a cross point gain can be adjusted only when the point is connected; when it’s not, 
an error message will appear when you select this option: 
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The following windows show the gain adjustment of an input line and an output line (between -
12 and +12 dB for all the lines except for MIC/LINE ones that can be set between -40 and +24 
dB) and the adjustment of a stereo cross point: 
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4.1.3.5. Layer Processes [All Layers]. 
 
This option allows you to select whether the processes that will be applied in the input line will 
affect to all its physical lines or not. This option is only available in the menu associated to input 
lines. 
 

 
 
When a process is activated in an input line, it will be shown in the XY view by means of a 
yellow square and in the associated context menu by means of a tab activation: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
4.1.3.6. Compressor / Limiter. 
 
This option allows you to access to the window where you can select one pre configured 
process of that kind (“Preset”), modify its parameters  and active/deactive it in the selected line. 
This option is only available in the menu associated to input lines. 
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4.1.3.7. Noise Gate. 
 
This option allows you to access to the window where you can select one pre configured 
process of that kind (“Preset”), modify its parameters  and active/deactive it in the selected line. 
This option is only available in the menu associated to input lines. 
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4.1.3.8. Delay. 
 
This option allows you to access to the window where you can select one pre configured 
process of that kind (“Preset”), modify its parameters  and active/deactive it in the selected line. 
This option is only available in the menu associated to input lines. 
 

 
 
 
4.1.3.9. Reverb. 
 
This option allows you to access to the window where you can select one pre configured 
process of that kind (“Preset”), modify its parameters  and active/deactive it in the selected line. 
This option is only available in the menu associated to input lines. 
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4.1.3.10. Equalize. 
 
This option allows you to access to the window where you can select one pre configured 
process of that kind (“Preset”), modify its parameters  and active/deactive it in the selected line. 
This option is only available in the menu associated to input lines. 
 

 
 
4.1.3.11. Low/High Pass Filter. 
 
This option allows you to access to the window where you can select one pre configured 
process of that kind (“Preset”), modify its parameters  and active/deactive it in the selected line. 
This option is only available in the menu associated to input lines. 
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4.1.3.12. Test Tone. 
 
This option allows you to access to the window where you can check the kind of signal test that 
is activated and select another preset of the same kind (tone, pink noise or white noise). That 
kind of signals can not be deactivated. This option is only available in the menu associated to 
“Test Line” type input lines. 
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4.1.3.13. Edit Output Label. 
 
This option enables you temporarily to change the output 
line label to make matrix operation easier for the user. 
When you exit this view, the temporary label assigned is 
lost. This option is only available in the menu associated 
to output lines or cross points. 
 
 
4.1.3.14. Edit Input Label. 
 
This option enables you temporarily to change the input 
line label to make matrix operation easier for the user. 
When you exit this view, the temporary label assigned is 
lost. This option is only available in the menu associated 
to input lines or cross points. 
 
 
4.1.3.15. View VU´s. 
 
With the context menu that opens when you right-click an input or output, you can 
obtain an individual display of the level of the line selected. This option is only 
available in the menu associated to input or output lines. 

 
 
 
 
 
 
 
 
 

 
4.1.3.16. Clear Selection. 
 
This eliminates the selection of all the cross points that have been chosen, for both their 
connection and their disconnection. 
 
4.1.3.17. Refresh. 
 
Also accessible by pressing F5, it refreshes the image. The software disconnects and re-
connects refreshing all the information from the controller. 
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4.2. New Vumeter View. 
 
The “New Vumeter View” option in the File menu lets you see the levels of the selected system 
signals. 
 

To add a VU meter, simply click on the button . 
 
To delete one of the VU meters that are being displayed, select the label shown at the foot of 

the VU meter, which will then appear highlighted in grey, and click on the button . 
 
When you place the mouse pointer over a VU meter, the data for each signal component are 
shown: signal type, name, physical line, etc. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When you want to display the level of a signal, you are making one of the DSP boards dedicate 
its processing resources to the performance of this function. Eliminating a VU meter from this 
display does not imply that this function is no longer carried out. To release the function, you 

have to use the  button, by means of which you can perform two operations:   
 

• Delete and STOP Sending: eliminates all the 
previously selected VU meters in  the view from 
display and processing.  

• STOP ALL VUMeters (except this view): stops 
the processing of all the signals that are not in that 
view. 
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4.3. New Connection View. 
 
This option lets you filter the view of matrix connections and act directly on the connections that 
must be modified. 
  
When you select it, it will open the “Connection View“ window. As many “Connection View“ 
windows as necessary can be opened. Only the connected cross points are shown in the list. 
 

 
 
There is one row for each cross point made between an input and an output. The input is 
shown on the left in blue, the output on the right in black. The fields that appear for every input 
and output are: 
 

• Name: Name of the line (maximum 30 characters). 
• Description: Description of the line (maximum 30 characters). 
• Line Type: Input, Output, Input/Output or Sum Bus. 

 
The left column shows the inputs where there is an active process, by means of the symbol . 
 
There is also a “Protect” field that shows if the cross point is protected, so that its status cannot 
be changed. 
 
To edit a cross point represented in the table, use the context menu that is displayed by right-
clicking the mouse, or select one of the icons at the top right of this window. 
 
Each field of this list can be filtered to show just the cross points you want to edit. To do this just 
select the down arrow by the field 
title and make the filter you need, 
by selecting an specific name, 
description or line type or by means 
of “Custom…” option . If you select 
this option, the following window 
appears where you can define a 
more complex filter by means of 
logical functions:  
 
 
 
 
If you have defined one or more filters and one of them is active, then at the top of “Connection 
View” screen you will see this filter and and it will enable you to close it (by pressing the x), to 
active or deactive it (by activating or not the next checkbox), to active another filter (by selecting 
it in the list that appears when you select the down arrow) and to edit and/or save it (by 
pressing the “Customize…” button): 
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4.3.1. Buttons in the connection view. Context menu (right-click). 
 
After selecting a connection, you can use the buttons in the connection view to find out more 
about it or edit it.  
  

 
 
You can also right-click on any of the connections in the list, and use the context menu that 
appears. 
 
The available options are the following: 
 

  
 
 

 

 
 
 
 
 
 

 

  
 

 

Disconnect: to disconnect the cross point. 
 

 
Protect: to protect it or remove the protection. 
 

 
Level gain: to adjust the gain levels of the input, output or cross point. 
 
DSP: to access to processes list, edit them and active/deactive the desired 
process or processes in the selected line. 
 

View Physical Connections: to verify the actual physical connections that are 
grouped together in a logical connection. 

Context 
Menu Only 

 

Context 
Menu Only 

Rename View: to give the view another name. 
 
 

Edit View Colums: it allows to activate a button on the left 
to select which colums will be visible. 
 
 

 
 

Exit: to leave this screen. 
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4.4. New Schedule View.  
 
This lets the user see the schedules previously defined by means of “BC 2000 D Matrix Setup“ 
application. A “Schedule“ is the automation of simple switches, macros or salvos at specific 
moments or with a certain frequency. 

If there are several schedules in the list that appears, you can filter the list display by selecting 
various parameters for each of the fields that are shown (“Name“, “Description“, “Start Time“, 
“End Time“, etc.) or you can make a more complex filter by means of “Custom…” option (a 
window like the one defined in section 4.3 appears). 
 
 
4.4.1. Schedule adjustment display. Schedule Settings. 

To access this display, select the desired schedule and press the button : 
 

 
 
From this window you cannot modify the “Schedule” options; you can only view them. 
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The schedule may consist of an action on a cross point (connection or disconnection), 
execution of a salvo or execution of a macro. From the setup software you can create repetitive 
schedules on a daily, weekly or monthly basis. In any case, the exact time when the scheduled 
action begins and ends can be established, as can the period of validity for the repeated 
schedule and the repetition interval. 
 
Each schedule is assigned a “Name“ in the respective box, as well as a Description. You will 
then need to establish what type of action you want executed (“Cross Point“, “Salvo“ or 
“Macro“) and what to do in case a conflict arises. 
 
All these adjustments are shown in the “Schedule Settings“ window. 
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4.5. New Alarm Status View.  
 
This screen makes it possible to check the alarm logs, duly filtered according to the type of 
events that need to be checked. The alarms to be displayed must be configured beforehand in 
the setup software. 
 
If the system detects a situation that has been programmed to generate an alarm, a blinking 
red indicator will appear in the lower right-hand area of the main real-time control (RTC) 
software screen.   

 
Pressing this button will open a window like this one: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The “Alarm Status View” window displays the information concerning all the alarms previously 
defined by means of the setup software, showing their status, and allows you to pause/resume 
or enable/disable any one of them. 
 
This window shows the name of each alarm, a description (“Alarm Alias”), the event that 
generates the alarm (no audio, power fail, communication error, etc.), the type of event 
(“Software” or ”Hardware”), if the alarm is enabled or not (“Enabled”), the “Status” and if  the 
alarm is active at that moment (“Alarm ON”). 
 
If you press the “Pause” button, it stops the selected alarm although the event that has 
generated it is still active (if this event disappears and then appears again, the alarm gets 
active and it is shown again). You will be asked for a confirmation to pause an alarm: 

 
 
 
 
 
 
 
 

 
The “Status” column changes from  to . 
 
If you press the “Resume” button, it resumes the selected alarm, so if the event that generates 
it is still active then the alarm gets active again. 
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You will be asked again for a confirmation: 
 
 
 
 
 
 
 
 
 

The “Status” column shows the symbol  again. 
 
By pressing the “Disable” button, you can disable the selected alarm. If an alarm is disabled 
and the event that generates it appears, the alarm does not get active until it is enabled again. 
 
By pressing the “Enable” button, you can enable again the selected alarm. 
 
In both cases you will be asked for a confirmation: 

 

   
 
The “Enabled” column shows if an alarm is enable  or not . 
 
Associated with each alarm you will see additional information when you press the  icon. The 
information displayed (inside a blue box) is the following: 
 

• Init. Delay: this is the time it takes to execute the relevant action each time the alarm in 
question is detected. 

• End Delay: this is the time it takes to carry out the action designated for execution 
when the cause of the alarm disappears. 

• Macro ON: this is the action or set of actions that is executed when the alarm is 
detected and after the time indicated in the “Init. Delay” field has elapsed. 

• Macro OFF: this is the action or set of actions that is executed when the time entered 
in the “End Delay” field has elapsed after the alarm has disappeared. 

• Alarm Data: indicates the cause of the alarm and where it is generated. 
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4.6. New Log View. 
 
The system maintains a log of all the users’ actions, or actions by the system itself (to do this, 
this option must be previously activated by means of the setup software). Selecting “New Log 
View” in the pull-down menu will open the following informative window: 

 
To load a log, select it from “Available Logs“ list and then press “Load Log“. To update the 
Available Logs list (and the information included), select the button “Refresh Log List“ and then 
load the log again. 

 
When you load a log, a table similar to this appears: 
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This table shows the date, time, event, user and location from which the action was executed 
(at the top right of this window the types of action that will be registered are shown, as 
previously defined by means of “BC 2000 D Matrix Setup“ application). Associated with each 
event is a drop-down list that shows more specifically what the action performed consisted of. 
 
The example shows a serie of events generated by a user (“Admin“) and by the system itself 
(“CONTROLLER“). The four first events corresponds to modifications of a cross point gain done 
by “Admin“ user from the IP address 172.31.0.55, corresponding to the computer used to 
connect to the system. 
 
The following example shows an alarm (“NO DIG IN 001“) that is enabled by “Admin“ user on 
06/09/2006 at 10:41:39. Then this alarm gets active by the system (“CONTROLLER”) due to a 
lack of audio in input ”DIG IN 001”. This trigger, in turn, another serie of events, because the 
alarm is associated with the automatic execution of a macro that executes a salvo to disconnect 
”DIG OUT 001” with ”DIG IN 001” and to connect this output with ”DIG IN 002”. 

 
Logs can be saved and printed: 

 

 “Save Log To File”: to save the log to a text file. 

 ”Print Log”: to print a copy of the log. 
 
Anytime you open a ”Log View”, the system save automatically the log files in the folder where 
the application is installed (in a new folder named ”log”). 
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4.7. Open View.  
 
This screen lets you open previously saved views. Once a view has been selected from the list, 
it is opened using the "Open View" button. By means of “Default” button you can make the 
selected view the default one (the one that will be displayed each time the system is started 
up). You can also delete an existing view (“Delete View”) or edit it (“Edit View” allows you to 
change the name of the view, select it as the default one or change the selection of the user 
that will have access to that view). 

 
 
 
 
 
 
 
 

4.8. Save View. 
 
When you have finished preparing a view, you can save it from this window, assigning a name 
that will allow you to recognize it from the “Open View” window for later use. You must choose 
which user(s) will have access to each view, and whether it will be the default view that will 
open for those users. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Once a view (or several) is created, if you send again the configuration by means of “BC 2000 
D Matrix Setup“ application (whether it’s sent by means of “Save Configuration & Reload” or 
“Save Configuration & Reset” option), those views will be lost. If you wish to save them, the 
procedure will be as follows: 
 

- Create the necessary views and associate them to the desired users by means of “BC 
2000 D Matrix RTC” application. 

- Select “Save configuration into frame” option in the File menu. This option is only 
available for the user or users with higher priority level. You will be asked for a 
confirmation: 

 

 
 
- Open “BC 2000 D Matrix Setup” application and download the configuration from 

frame to PC by means of “Read config from frame” option in “Books” section. 
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This way, the next time you send the configuration from Setup, when you select the “Open 
View” option in the RTC all the views previously created will appear. 
 
In the case of several workstations with the software installed in order to access to the system, 
once the desired views are created at one of the stations (usually Central Control), if you wish to 
have those views available at the other stations, you will have to follow the previous procedure 
and add the following steps: 
 

- In those workstations where views have not been created, select “Load configuration 
from frame” option in the File menu of the “BC 2000 D Matrix RTC” application. This 
options is only available for the user or users with higher priority level. This way the 
application is forced to download again the system configuration from the frame. The 
application will get closed. 

- Open again the “BC 2000 D Matrix RTC” application at those workstations. The 
previously created views will be available now. 

 
When after creating a series of views, saving them in the frame (by means of RTC) and 
downloading the configuration from frame to PC (by means of Setup), you send again the 
configuration (whether it’s sent by means of “Save Configuration & Reload” or “Save 
Configuration & Reset” option), in those workstations where “BC 2000 D Matrix RTC” 
application is open the following indication will appear in the lower area: 

 

 
 

Just by closing and opening again the application, the new configuration will be downloaded 
from the frame and the previous changes will be available in those workstations. 
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5. DROP-DOWN MENU: VIEW. 
  
5.1. Tool Bar. 
 
This will display the following tool bar: 
 

 
 
The buttons at the left side of the tool bar provide access to some of the options in the File 
menu: “New Connection View”, “New Logical XY View“, “New Vumeter View“, “New Alarm 
Status View“, “New Schedule View“ and “New Log View“. You can find extended information 
about the features of these views in section 4. 
 
There is also access to the configuration of programmable buttons (“Prog Buttons“). 
 
At the right side, there is an information field indicating which configuration “Book” is active. 
 
Also at the right, there is a button for access to the “Panic” option and a button to exit the 
application (“Exit RTC”). 
 
5.1.1. Panic Function. 
 
When you press the “Panic” button, the following window appears, in which you can choose 
the panic function you want to execute from the available functions for the current user (a blank 
list will appear if the mask associated to that user and the masks associated to the defined 
functions are different): 
 

 
 
When you select one of the available panic functions and press the “Exec” button, the 
associated macro will be executed. When there is any conflict  in the macro execution (some of 
the cross points are protected, for instance), only those macro actions that are not in conflict will 
be executed. If the request for user confirmation were established when macro was configured, 
the following message will be displayed when you press “Exec”: 
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5.2. Connection Panel. 
 
This will display the following bar:   
 

 
 
From here, the three types of logical elements that the matrix works with can be immediately 
connected or executed: logical lines, salvos and macros. 
 
To do this, locate each logical element according to the group it belongs to and its name. In the 
case of lines, the connection can be protected by marking the “Protect” box (or unprotected by 
marking “Unprotect”); if the user has the right to do so, he can also override a 
protection using the “Override” box.  
 
Search View. 
 
When the search button (represented 
by a magnifying glass) is pressed, the 
“Search View” screen is displayed; 
this provides access to the different 
elements related to that field. You 
can write the search criteria and the 

view is filtered. The  button 
validates the selected option. 

 
 

 
 
 
 
 
5.3. Touch Panels. 
 
From the drop-down View menu you can activate the display of one of the panels previously 
defined by means of the configuration software. When you select “Touch Panels” (this option 
only appears if there is some panel defined for present user), a list of the defined panels 
appears and when you select one of them a window similar to this is displayed: 
 
 
 
 
 
 
 
 
This touch panel window will have the characteristics implemented previously in your 
configuration as regards position, number and type of buttons and the actions they perform. 
The button may have a single operation associated (it will perform only a function when is 
pressed) or a double one (it will perform different functions depending on whether it is activated 
or deactivated). 
 
When a user presses this button, the circle inside change to green and the actions previously 
defined will be executed. If the request for confirmation were selected when it was configured, 
the following message will be displayed (it will be displayed whether it is activated or 
deactivated if the button have a double operation): 
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If your system has a suitable interface, each button can be activated by touching it on the 
screen. If not, the buttons defined can always be pressed by clicking on them.  
 
5.4. Prog. Buttons. 
 
From the drop-down View menu you can select the “Prog. Buttons“ option to show the 
programmable buttons that have been previously defined. These buttons appear on a bar 
located under the “Tool Bar“ and/or the bar of the “Connection Panel“ for logical lines.   

 
 

 
 

To define a programmable button, select the  button in the “Tool Bar”. 
 

In the window that appears, press and the following window is displayed: 
 

 
From this window you can assign a combination of keys on a keyboard (“Shortcut“), give a 
button a position in the programmable button bar and associate it with a macro that will be 
executed when you press the defined combination of keys or when the button is pressed from 
the interface. Each button is associated with a macro belonging to a specific work group. The 
button may or may not appear on the “Prog  Buttons” bar (by activating or not the “Show On 
Bar“ checkbox). 
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5.5. Schedule Status View. 
 
You can use this window to control, in real time, the execution of each one of the scheduled 
tasks. At the top of the window you will see a control panel that will enable you, on one hand, to 
customize the display, and, on the other hand, to act on the pending tasks or generate new 
ones. 

 
In the centre of the control menu the current time is shown in green, and the time when the next 
action will be executed is displayed in red (5 seconds before it is executed the red clock starts 
to blink). The part of the control panel to the right of the time display lets you select the time 
range of the events displayed, for both past and future events (“View Last Days” and “View 
Next Days”). You can key in a specific range of days or use the single up and down arrows to 
increase or decrease the range by one-day intervals, or you can press on the double arrows 
shown to the left and right to increase or decrease the range by ten-days intervals. 
 
The events that have already taken place (“Done”) are displayed in grey. All the events that are 
about to be executed (“Next Pending”), and which fall within the time range defined by means 
of the “Hot Events Hours” option, are displayed in red. Because the time range for this option 
extends from 0 to 1,024 hours, all the actions that fall within the selected time interval with 
respect to the first action awaiting execution will be displayed in red. Press the single up and 
down arrows to increase or decrease this interval by one-hour increments. The double arrows 
to the left and right will allow you to increase this hourly interval in 10-hour increments. 
 
The events are shown around the time at which the programming display is started; thus, the 
first event pending execution will appear in the center of the list. This listing will be refreshed 
every so often: the “Autorefresh Each Hours” option lets you select this autorefresh interval. 
The simple up and down arrows enable you to increase or decrease this interval in one-hour 
increments. The double arrows to the left and right allow you to increase and decrease it by 10-
hour increments. The “Refresh display data” serves to manually refresh the event list that is 
currently being displayed.  
 
The parameters shown in the list have the meanings set forth below: 
 

• “Task Status“: this is the current status of the scheduled task.  This parameter can 
have the following values: “Done“ (an already completed action), “Next Pending“ (is the 
next task that will be performed), “Pending“ (tasks that are awaiting execution), 
“Paused“ (an action that has been paused), “Canceled“ (a task that has been canceled) 
or “Deleted“ (an action that has been definitively eliminated).  

• “Time“: this is the time at which the action is executed. 
• “Priority“: indicates the level of priority in the execution of the action. 
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• “Type“: the action may have been programmed when the system was configured, or it 
may have been requested by the real-time control system user (“User Action“). If the 
action is a previously scheduled one, the action type will be “Start Action“ or “End 
Action“.  

• “On Conflict“: indicates what type of action will be taken in case of conflict. The 
possibilities are: “Normal“ (executes those actions within the function that are not in 
conflict and does not execute those that are), “Cancel“ (it will completely prevent the 
execution of all the actions, whether they are incompatible or not) or “Overwrite“ 
(ignores any incompatibilities and prioritizes the execution of the action over the 
incompatibility generated).  

• “Schedule Name“: this is the name that was given to the scheduled action. 
• “Action“: describes the action that the programmed task will carry out. 

 
You can “Pause“ or “Cancel“ a pending task, and you can enable again (“Pending“) 
or cancel a paused task, only when the priority level of the current user is the same or 
higher than the one defined in the configuration of that event. In the list, by means of 
the contextual menu that appears when you right-click a given event, you can also 
execute the “Cancel“, “Pause“ and “Pending“ actions, as appropriate. 
 
 
 
 

To previously scheduled tasks you can add new actions, by means of the “New” option, or 
modify the existing ones, by means of the “Edit” option (only when the priority level of the user 
is the same or higher than the priority level of the task). The following window appears where 
you can modify all the parameters that defined the action: 

 

 
 
The priority level of the task (“Task Priority”) can be configured with the same or a lower value 
than the priority level of the user that creates the new action or edit an existing one (it is shown 
as “Your priority is…”). 
 
When you add a new task to the list, you indicate the transmission of the 
event to the system (the “TX“ indicator is highlighted in green) and the 
reception by the system of this new action (the “RX“ indicator is highlighted 
in red). The “WK“ indicator is highlighted in yellow when the event viewer is 
starting up, before displaying the list of actions. 
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5.6. Active VuMeters. 
 
When you select “Active VuMeters” from the “View” menu, the window shown down here is 
displayed, with a list of all the active VU meters of the system (the logic line and the physic lines 
each one consists of are shown). You may select any of the physical lines that appear and 
deactivate the analysis of the corresponding signal to generate the VU meter (by means of 
“Deactive VuMeter” button). When you deactivate the corresponding line, the associated VU 
meter will no longer be generated, and therefore it will not be possible to display the level 
variations experienced by that signal in any VU meter view that the various users may have 
open. The “Deactivate ALL” option remove all the VU meters from that list. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Press the “Refresh” button to update the list of VU meters that are being created in the system.  
 
 
5.7. Active Processes. 
 
When you select “Active Processes” from the “View” menu, the window shown down here is 
displayed, with a list of all the active processes of the system (the logic line and the physic lines 
each one consists of are shown). You may select any of the physical lines that appear and 
deactivate the process or processes active in that line (by means of the “Deactive Process” 
button). When you deactive the corresponding process, it will stop being applied on that physic 
line. The “Deactive ALL” option deactive all the processes of the list. 
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5.8. Card Changes View. 
 
When there are input/output boards in the system configured as backup modules, the “Card 
Changes View” option allows you to check the system status on that matter. 
 
In the example, there is a BC2202 board (digital inputs/outputs) placed in slot 14 that is 
configured as backup module of any other BC2202 module in the system. If the module placed 
in slot 13 has any problem and stops being active, automatically that module (R-13 in “Source” 
column) is replaced by the module in slot 14 (R-14 in “Target” column) and it starts managing 
the logical lines defined for the first one. 
 
If after that, the module placed in slot 13 gets back and is registered again in the system, 
automatically the backup function that was associated to the module in slot 14 (R-14 in 
“Source” column) becomes associated to the module in slot 13 (R-13 in “Target” column), that 
is configured then as backup module of any other BC2202 board in the system. 
 

  
 
  
5.9. DSP Usage. 
 
You can display the percentage of workload of the DSP boards for each type of function. The 
functions performed by the DSP boards are:  
 

• “Routing“: this type of DSP board specializes in sending inputs to not summable 
outputs. 

• “Matrix“: matrix DSP boards sum several inputs on a single output. 
• “Audio Process“: these are the DSP boards that perform audio processing. 
• “Vu Meters“: this is the DSP board that generates the VU meters for those signals that 

are selected for visual monitoring. 
• “Codec “: these are the DSP boards that perform E1/T1 line encoding. 

 

 
 

When you place the mouse pointer over any of the four functions, a message will be displayed 
indicating which DSP boards (quantity and position) are executing that function. 
 
The number of DSP boards configured in Backup mode is also shown on the right. 
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6. DROP-DOWN MENU: USER. 
 
When you select “Change User” the following window is 
displayed, that allows you to change the user (you have to 
write down the corresponding password if that was defined 
when that user configuration was made). 
 
 
 
 
 
7.  DROP-DOWN MENU: WINDOW. 
 
This lets you change the way the information is organised on the screen: 
 

• “Cascade”: cascades the windows.  
• ”Tile Horizontal”: tiles the windows horizontally.  
• ”Tile Vertical”: tiles the windows vertically.  
• ”Arrange Icons”: organises the icons. 
• ”Minimize All”: minimizes the windows. 
• 1,2,3,4...: allows quick access to the available windows. 

 
 
8. DROP-DOWN MENU: REFRESH.  
 
When you select ”Refresh” from the drop-down menu, you update the display of all the data in 
the interface based on what is being executed in the system at that moment. Also accessible by 
pressing F5. 
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9. APPLICATION UPGRADE. 
 
To upgrade “BC 2000 D Router“ software to a new version you have to: 
 

1. Make a backup copy of the folder where “BC 2000 D Matrix Setup“ and “BC 2000 D 
Matrix RTC“ applications are installed (“C:\Program files \AEQ\BC-2000 D\Matrix 
Software” by default; “C:\AEQ\BC-2000 D” for versions before 1.4.2.12). 

2. Uninstall previous version of the applications. 
3. Install software new version (“MatrixSetup.exe“, included in the BC2000D CD, allows 

you to install both applications at one time). 
4. Read full configuration from frame and make a backup copy (by means of “BC 2000 D 

Matrix Setup“ application). 
5. If there have been changes, install the new version of “BC 2000 D Firmware Upgrade“ 

application and copy the new firmware files into your PC. 
6. Run “BC 2000 D Firmware Upgrade“ application, check and upgrade the firmware of 

I/O boards (the right order is: Micro - FPGA), DSP boards (Micro - DSP - FPGA) and 
controller board (only Micro and FPGA). You will find the list of new versions in the 
BC2000D CD. Close the application. 

7. “Save Configuration & Reset“ (by means of “BC 2000 D Matrix Setup“ application). 
8. Run “BC 2000 D Firmware Upgrade“ application and upgrade secondary BC2240 

Supervisor. Close the application. 
9. Run “BC 2000 D Firmware Upgrade“ application and upgrade secondary BC2240 

Controller. Close the application. 
10. Run “BC 2000 D Firmware Upgrade“ application and upgrade primary BC2240 

Supervisor. Close the application. 
11. Run “BC 2000 D Firmware Upgrade“ application and upgrade primary BC2240 

Controller. Close the application. 
12. “Save Configuration & Reset“ again (by means of “BC 2000 D Matrix Setup“ 

application). 
13. Power off the frame. Wait 5 seconds and power on. 
14. Run “BC 2000 D Matrix RTC“ application and check that the system is working 

correctly. 
 
In single controller matrix systems, ignore steps 8 and 9. 
 
Please be specially careful upgrading the BC2220/BC2221 and BC2240 firmware (there is 
specific firmware for Matrix). 


